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1. Background and Legal Information
The ShakeAlert® Earthquake Early Warning system (ShakeAlert EEW system, ShakeAlert
system, ShakeAlert, system) detects significant earthquakes so quickly that alerts can reach
many people seconds to tens of seconds before shaking arrives. The USGS has been
developing the ShakeAlert system for California, Oregon, and Washington since 2006,
jointly with partners from state governments, universities, and private foundations.
ShakeAlert is part of the Advanced National Seismic System. For more information see the
USGS Revised Technical Implementation Plan for the ShakeAlert system:
https://pubs.er.usgs.gov/publication/ofr20181155.

The ShakeAlert system combines the output from two independently running EEW
algorithms, Finite Fault Detector (FinDer) and Earthquake Point-source Integrated Code
(EPIC), that use recorded ground motion data to estimate source parameters for an
earthquake in progress. The ShakeAlert system provides a continuum of earthquake
information including rapid estimates of location, magnitude, and seismic intensities.
Magnitude represents the amount of energy released and intensity is the amount of
shaking, and is a relevant measure for potential damage.

Outputs of the ShakeAlert system come in the form of  XML formatted ShakeAlert Messages
published by the U.S. Geological Survey. EEWDisplay is a user-facing demonstration product
that visualizes data in ShakeAlert Messages and produces an alert.  Earthquake Early

Warning Display (EEWDisplay) is powered by the ShakeAlert® system.

Since EEWDisplay requires a connection to the ShakeAlert server, all end-users must
have a license agreement on file with the USGS.

EEWDisplay is a Java-based application that presents visual and audio information about an
earthquake. Its output shows the end-user's location and the estimated epicenter. As time
elapses from the detection and notification of an earthquake, the current locations of the
Primary (P) and Secondary (S) wave fronts are also shown. Additionally, the estimated
magnitude, shaking intensity, and remaining time until shaking is estimated to start at the
end-user's location, is displayed. If the end-user configures EEWDisplay to ingest contour
or grid map messages, estimated shaking intensity across the map display will also be
shown.

EEWDisplay is for demonstration use only and should not be used for life-safety
applications.

ShakeAlert-powered EEWDisplay alerts are stored locally on the end-user’s computer and
can be replayed. EEWDisplay also has a “Heartbeat” feature which provides a summary of
the state of health of the components (e.g., algorithms) of the ShakeAlert system and
provides the end-user confirmation that the connection to the ShakeAlert server is active.
Additionally, ShakeAlert technical partners with active Pilot or License to Operate
agreements can use EEWDisplay with the ShakeAlert Scenario Server for testing purposes.
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From the ShakeAlert Evaluation License Agreement (July 2021 Section 9:
Disclaimers; Warranties; Limitation of Liability.): “EEWDisplay Users are not authorized to
copy, modify, reverse-engineer, publish, rent, lease, loan, sublicense, or distribute ShakeAlert Materials
or derivative works based on ShakeAlert products to any third-party without the prior written consent
of the USGS. Additionally, Users must obtain prior written approval from the USGS for any public
information releases which refer to the Department of the Interior, the USGS, its employees, or
ShakeAlert Materials. Development and testing of the ShakeAlert system is ongoing.”

The USGS does not warrant that EEWDisplay will function at all times, in all geographic
areas, without interruption, be error-free, or that any errors will be corrected. End-users
are prohibited from critical actions or making important decisions based on
ShakeAlert information as visualized through EEWDisplay. As stated above
EEWDisplay is for demonstration use only and should not be used for life-safety
applications.

ShakeAlert’s Joint Committee for Communication, Education, Outreach, and Technical
Engagement  (JCCEO&TE) collaborates with a variety of stakeholders, including
EEWDisplay end-users, to develop messaging and visual representations of ShakeAlert
data. Input from the ShakeAlert technical partner community is indispensable in this
process.

The USGS seeks Pilot Phase Partners to cooperatively develop products, services, etc. that
use ShakeAlert Messages in real-world applications. To learn more about ShakeAlert
technical partnerships, visit https://shakealert.org/implementation/partners.

EEWDisplay produces ShakeAlert-powered alerts from USGS published ShakeAlert
Messages. (see section Menus > Top Menu Bar > Edit > Settings > Event Filter Parameters
for details of the User threshold behavior). Note: Computer cannot be off or in sleep mode.
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2. Download and Installation

Currently, EEWDisplay is only being distributed to a limited number of licensed partners.
Upon being authorized to access ShakeAlert servers, you are issued a personal username
and password for installation.

It is prohibited to share ShakeAlert server credentials. The USGS maintains the right
to refuse, suspend, or terminate access to anyone at any time without notice.

Step 1. Download software
● Go to https://www.ShakeAlert.org.
● Within the home page for ShakeAlert.org, access ShakeAlert Utilities at the bottom

right-hand side of the page.
● The Utilities page is protected with a generic password which was provided to you

with your access codes.
● Access the Download and Installation tab.
● It is recommended that you read the README file in the download directory for

further information on system requirements, installation and relevant updates
before you download the software.

Step 2. Select the installation appropriate to your operating system for download
● Windows: EEWDisplay-X.X.X_yyyymmdd.installer.exe
● Mac: EEWDisplay-X.X.X_yyyymmdd-osx.installer.dmg
● Linux: EEWDisplay-X.X.X_yyyymmdd-linux.installer.run
● UNIX: EEWDisplay-X.X.X_yyyymmdd.tgz

(On UNIX, after extracting the files from the tgz archive, to run, use the
runUNIX.sh script)

Step 3. Both Windows and Mac require any program downloaded from the Internet to be
digitally signed before it will allow the program to be run.  (Linux and Unix files are not
digitally signed at this time.

● Windows: Right mouse on exe file, select properties then select digital signatures.
Verify that the installer is signed by California Institute of Technology with a valid
date by looking at the details at one or more of the certificates.

● Mac: To manually validate the signature enter the following command in a terminal
window:
codesign --verify --verbose <path to EEWDisplay-X.X.X.YYYYMDD-osx.installer.dmg>

The output should indicate that the file is valid on disk and satifies its designated
requirement.

Step 4. Uninstall previous or pre-release EEWDisplay or UserDisplay versions
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You must stop and uninstall any preliminary version of 2.8.0 such as a beta or pre-release with
the same version number.  Failure to stop and install without properly uninstalling first may
cause the program to lock up and/or cause the installation to fail.  You may need to restart
your computer if you do not stop the program before uninstalling.

If you are running an earlier version of the formerly called UserDisplay (2.7.0 or earlier) you
can uninstall it AFTER you successfully install the new version of EEWDisplay 2.8.0.

After you install version 2.8.0, you can copy any history files from a previous version to
keep them available for replay.  See README file for instructions:
https://www.shakealert.org/eew-research/caltech/eewdisplay/shakealert-utilities/shake
alert-utilities-2/documentationuser-guides/

To uninstall older versions of EEWDisplay or UserDisplay, use the uninstaller in the
program installation directory, or use one of the following options:

● Mac: drag the EEWDisplay or UserDisplay folder to the trash.
● Windows: use the Control Panel uninstall option (Start menu > Control Panel >

Programs and Features > right-click on a program and select uninstall).
● Linux/Unix: delete the EEWDisplay folder.

Step 5. Install Program
If you are having difficulties with the installation, please ensure the person performing the
installation has administrative privileges on the computer in order to complete the install
and that the end-user has both read and write permissions for the folder where the
installed application is running.

Step 6: Run EEWDisplay
Once the program is fully installed, you should find a shortcut for the EEWDisplay on your
desktop. Do not forget to turn on your computer’s volume so you can hear the alert tone
and voice announcements when a ShakeAlert-powered alert is delivered by EEWDisplay.

Double-click on the icon and manually enter your personal username and password to
start your  EEWDisplay. If you need to see your password in clear text during or after you
enter it on the dialog, check the “Show PassPhrase” box. If you check the “Autologin” box
under Settings, you will not need to enter your credentials again unless you install a new
version. Please note that you should only check the “Autologin” box once you have verified
that your credentials are correct, by seeing the connection status change to green after your
first log in. Also, remember to go into “Settings” and enter your latitude/longitude to set
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your location, map center and your magnitude and intensity thresholds for receiving alerts.
For further information on setting alert thresholds, or other parameters, please see section
Menus > Top Menu Bar > Edit > Settings.

On Windows or Mac OSX you can set the EEWDisplay to be restarted automatically when
your computer is restarted. On Windows, the installer will set the auto restart option by
default (to disable use Windows Task Manager > Settings > Startup). On Mac OSX, put the
EEWDisplay application program in the list of "Login items" for your User (System
preferences > Users and Groups > Login Items).

If you experience technical difficulties with the EEWDisplay or have any comments, please
contact the appropriate ShakeAlert Regional Coordinator:

Southern
California

Margaret Vinci
(Caltech)

mvinci@gps.caltech.edu 626-395-3298

Northern
California

Jennifer Strauss
(UC Berkeley)

Tal Edgecomb
(UC Berkeley)

jastrauss@berkeley.edu

tale@berkeley.edu

510-642-1067

Oregon Lucy Walsh
(University of Oregon)

lwalsh@uoregon.edu 541-346-4654

Washington Bill Steele
(University of Washington)

wsteele@uw.edu 206-685-5880

Washington
& Oregon

Gabriel Lotto
(University of Washington)

glotto@uw.edu

USGS Robert de Groot
(USGS)

rdegroot@usgs.gov 626-583-7225

Additional information regarding the ShakeAlert Earthquake Early Warning System can be
found at https://www.ShakeAlert.org.

Recent earthquake information is available at:
https://earthquake.usgs.gov./earthquakes/map

For earthquakes (within ShakeAlert’s service area) that are estimated by the ShakeAlert
system to be M 4.0 or greater, a ShakeAlert Post-ShakeAlert Message Summary is posted on
the given event page. Before being posted to the event page, the ShakeAlert Message is
reviewed and approved by a 24/7 USGS ShakeAlert Duty Review Officer.
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The EEWDisplay is a platform-independent Java Application. The program has been
successfully tested on Windows 7, 8, and 10; Windows Vista; Windows XP; Linux; and Mac
OS X. The program requires Java version 1.8 or higher. Please follow the instructions of the
installation manager. You must grant the EEWDisplay access through your firewall to be
able to receive ShakeAlert Messages.
Note: Within the ShakeAlert Utilities webpage, the Bug Report/Enhancement Request
Submission tab allows you to provide EEWDisplay feedback to the EEWDisplay development
team.

Recent Changes
Based on the feedback from our end-users and advances in algorithm development, the
following changes were made to the EEWDisplay:

1) The latest 2.8.0 version offers the following improvements and new features:
● Support to process new follow-up ShakeAlert Messages issued by the ShakeAlert

system, which provide verification and further details for the most recent event for
which a ShakeAlert Message was issued by the USGS.

● New ‘Acknowledge’ button which allows the end-user to stop the EEWDisplay from
popping-up and grabbing focus while still receiving and logging event alerts. Action to
‘Cancel’ event alerts is now limited to a key and mouse-click shortcut.

● Updated graphics for intensity scale, disclaimer and logo, improving the resolution and
appearance of the main EEWDisplay screen.

● Updated vs30 file with greater extent and newer data, matching the file used internally
by the ShakeAlert system when computing estimated ground motion. Reading of the file
is also optimised for speed.

● Updated ShakeAlert license agreement and end-user documents/manuals, plus new
menu options that will access the latest versions at  ShakeAlert.org.

● Example replay  data have been updated with recent earthquakes for which a
ShakeAlert-powered alert was delivered, updated historic examples more closely
imitating the expected ShakeAlert system performance, and synthetic scenarios for
large magnitude events.

● New Audio Settings options to ‘Mute’ on start-up and ‘Test Audio’ at start-up.
● New Event Filter Settings to set thresholds for audio alerts.
● New visual Setting to control animation update interval.
● Updated station and city files to reflect latest information.
● Updated default NTP server to reduce connection problems.
● Added checkbox to disable NTP synchronization for cases where connections to an

external NTP server are problematic. In this case the EEWDisplay will use the local
computer system clock.

● Updated behavior for connecting to ShakeAlert brokers to find optimum connection.
● Additional information on ShakeAlert server connections provided in Help->About

pop-up.
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● Bug fix to test audio files at start-up to prevent problems and provide information in the
log file. This test ‘chirp’ can be disabled in Settings for those who restart frequently.

● Bug fixes for handling username and password on login pop-up.
● Bug fix to stop checking NTP servers once a successful connection is made.
● Bug fix to correctly handle new HA messages (which provide details of the health of the

ShakeAlert system).
● Bug fix for shaking intensity level display.

2) Bug fixes for v2.8.0 are listed in the changes file launched from the Help > Changes
menu option.

3) EEWDisplay v2.8.0 requires Java 1.8 or newer. NOTE: There is a known problem with
Java 8 update 121, which was released January 17, 2017. This may cause the
EEWDisplay to flicker/incompletely refresh and/or the audio to be uneven during a
ShakeAlert-powered alert. It affects some video cards. Previous versions of the
EEWDisplay may also be affected by the recent java updates. Reverting to versions of
Java 8 prior to 101 or a more recent build should improve the display. It may also help to
disable some of the more detailed map layers.

3. Menus
There are three menu bars along the top of the EEWDisplay window.

Top Menu Bar

The Top Menu Bar displays items that, when clicked, reveal pull-down submenus of choices
to select.

EEWDisplay
Click this drop-down to turn off alerts, reconnect to program services, or exit.
● About EEWDisplay displays EEWDisplay version number and copyright information.

Additional information is also provided including: the time the program was started,
end-user information, system description, software library details, the EEWDisplay
properties file and start-up parameters, and alert connection information.

● Silence Alerts quiets the current alert. You can also use the keyboard shortcut Ctrl-S or
click the Silence button on the Button bar. This feature mutes ONGOING alerts, for
example to suppress audio alerts for distant earthquakes with long warning times that
may be irrelevant to the end-user.

● Mute All Alerts will silence all incoming and simulated alerts until the mute is
deselected. You can also mute alerts by clicking the Mute checkbox on the Button bar,
or by using keyboard shortcut Ctrl-M. The keyboard shortcut will toggle Mute on and
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off. You may wish to use this feature if there is an ongoing event swarm, or if you work
in a quiet environment where a visual alert is sufficient.

● Cancel Event stops an alert  from proceeding, whether an actual alert or an example
simulation. If you cancel an event, you will no longer receive updates of that event.
​Unless you are demonstrating and making use of example simulations, you should
not use Cancel Event, ​because it may result in you not receiving relevant alerts as
earthquake parameters are updated (e.g., as the earthquake rupture proceeds, it may
move closer to your location)​. Keyboard shortcut: Ctrl-C.

● Acknowledge Event will act on the current event to prevent the EEWDisplay from
popping-up and grabbing screen focus for event updates. The EEWDisplay will continue
to receive and log the updates, so they will be available for replays, and audio-visuals
will continue to update in the background. Keyboard shortcut: Ctrl-A.

● Reconnect to ShakeAlert Server will attempt to reconnect your EEWDisplay to the
ShakeAlert system; if successful, your Program Status Light will turn green (for more
details on the status light, see the Button Bar section). Keyboard shortcut: Ctrl-Shift-R.

● Reconnect to Time Server will sync your program with the NTP (official time) server. If
you get the message “NTP Status is currently OK”, you don’t have to reconnect or
“restart” the NTP synchronization.

● Exit will quit the EEWDisplay. You can also click the Power-off icon to quit, located
directly below on the Button bar (see Button Bar section). Note that this will
completely close the program and no alerts will be received. Usual operation is not to
exit the program but to close or minimize the EEWDisplay window using the standard
controls on the top right/left of the display (see section ‘Minimize/maximize and close
the EEWDisplay window’).

Replay
Offers shortcuts to replaying recent events: incoming, or simulated. It also shows the
available keyboard shortcuts for these actions.
● Play Event opens a file browser so that the end-user can navigate through the history

and examples archive and select an event to replay. Both .eew and .xml files are available
in the examples and history folders, .xml files will replay information for a single
ShakeAlert-powered alert, .eew files will play a sequence of .xml files. Example events
are described in further detail in section 8. The keyboard shortcut (ctrl+P) will also
open the file browser.

● Create Custom Event launches a pop-up dialog allowing the user to specify custom event
parameters for replay: epicentral latitude, longitude and depth (in km), and magnitude.
The shortcut: ctrl with a mouse click on the map, will also launch the pop-up dialog,
with the mouse click location being used to set the epicentral latitude and longitude. A
second shortcut is also available: a right-click, or two-finger click on Mac, launches a
menu of ‘Location options’. The third option is ‘Create User Event at this location’, and
will also launch the pop-up dialog with the mouse click location being used to set the
epicentral latitude and longitude.  Upon pressing ‘Play’, the EEWDisplay will begin to
display audio and visual alerts consistent with an event occurring at the given location.
Note that no map or contour ground motion alerts will be generated for this event, only
the standard source parameter alerts.
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● Replay Last Event replays the most recent event played or received by the EEWDisplay.
The keyboard shortcut (ctrl+R) will replay the most recently played event.

● Event listing displays recently played events for easy selection for replay. Up to 30
events are listed, using their event ID (for events received in real-time this may include
the date and time), magnitude, nearest city, and the number of updates in the sequence.
The keyboard shortcut (ctrl+R) will replay the most recently played event (number 1) in
the list.

Edit
Access your program settings such as the servers you are connecting to, your
latitude/longitude location, and other specified details.
● Settings is identical to the Settings button on the Button bar, click to open a dialog box

to input various details. Note that any feature with an asterisk will require a program
restart to take effect.
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o User Settings:
▪ Checkbox for AutoLogin: Check this box if you wish to be automatically logged

in each time you launch EEWDisplay. Enable only after you have confirmed that
your Username and Password have been accepted. The password is encrypted when
saved to disk, so please make sure you know your password before running any
new version.  Note: Any change to the ShakeAlert connection or alert topic will
automatically uncheck this checkbox.

▪ Checkbox for Restore Position and Size at Restart: Selecting this checkbox
stores the window position and size on shutdown so that they can be restored
when the program is relaunched.

▪ Checkbox for Auto Load Recent History: Selecting this will automatically load
recent events (up to a maximum of 30) into the event history layer when the
program is relaunched.

▪ User Home location (lat/lon/zoom): When you first install the EEWDisplay,
your latitude, longitude will point off the California coast, to remind you to
change this to your approximate location. Convert your address to lat/lon at
geocoder.us or www.latlong.net.  Some preset values are available with
approximate locations for the ShakeAlert collaborating institutions Caltech
(southern California; 34.1363, -118.1276), University of California Berkeley
(UCB, northern California; 37.8700, -122.2590), University of Oregon (UO,
Oregon; 44.0463, -123.0737), University of Washington (UW, Washington;
47.6540, -122.3095) and the location values at startup.
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▪ Map Center Location (lat/lon/zoom): Set the map center location and zoom
level. Zoom level has a ratio format like 1:6,000,000. Using the Preset values
available in the drop-down menu will set both the User Home Location and Map
Center, see above (User Home location) for further explanation.
A shortcut for setting your current map view as the default view is available from
the map: a right-click (or two-finger click on Mac) launches a menu of ‘Location
options’. The second option is to ‘Set current view as default’. This view will be
used if you ‘Reset Map’, when you re-start EEWDisplay, and if you use the ‘Last
Startup’ option in the Preset location options.
When moving the cursor across the map, the lat/lon values will be displayed in the
lower left corner. The zoom level is displayed in a text box near the top in the
navigation bar just below the "Play Event" button.

▪ Default buttons reset the lat, lon, zoom boxes to default values.
▪ VS30 Site Conditions [m/s]: Leave this at the default value. If the value 9999

appears in the box, or further explanation of this quantity is needed, read the
following Advanced end-users section.

Advanced end-users: Enter the Vs30 value (average S-wave velocity of the uppermost
30 m) at your location. This value is important for estimating the seismic intensity
at your site, and will vary depending on the rock or soil type in your local area.
Enter “0” if you do not know the Vs30 value at your site. The program will
automatically determine a Vs30 value from a lookup table using the latitude and
longitude you entered. If the automatic lookup attempt results in a value of “9999”
in the box, the lookup table file is absent or unreadable go to
https://earthquake.usgs.gov/data/vs30 or contact the appropriate person for your
region as listed in Section 3 (Download and Installation) or Section 5 (Contact
Information).

▪ Checkbox for AutoVS: Leave this at its default status, which is checked, unless
you have more detailed information about your site conditions.

▪ HDPI Font Size Multiplier: This setting is used to adapt the EEWDisplay to high
definition displays. The program attempts to set an appropriate level: 0.5, 1.0 or
1.5 depending upon available system information. However, if the font appears
too large the multiplier should be reduced, and vice versa. Higher definition
screens may need a higher value.

▪ Animation Update Interval dropdown: The end-user is able to select between
‘Medium’, ‘Slow’, and ‘Fast’, controlling the refresh rate for animations including P
and S wavefronts. Choose ‘Slow’ for older computers to reduce system load, and
choose ‘Fast’ for smoother graphics. Default is ‘Medium’.

▪ Map Graphics Quality dropdown: The end-user is able to select between ‘Low
Quality’, ‘Normal’ and ‘High Quality’, controlling the trade-off between the speed
and quality with which the view is redrawn. If the view is slow to be drawn,
select ‘Low Quality’.

▪ Checkbox for Map Double Buffering: Check this box to apply double buffering,
which may reduce stutter, tearing and other artifacts in the rendering of the view.
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o Event Filter Parameters:
▪ You can set alert thresholds, which determine whether the display will pop-up

and audio will be played for an incoming message.
▪ You can set audio thresholds, which only controls whether the audio will be

played. Setting the audio thresholds higher than alert thresholds allows you to
pop-up and display smaller events for which you may not want the interruption
of the audio alerts.

▪ All messages received from the ShakeAlert server will be written to disk, these
alert and audio thresholds are only used to decide how the program will notify
the user.

▪ To gain experience with the EEWDisplay, your Minimum Magnitude and
Minimum Intensity should be low enough to detect relatively small (and
therefore frequent) earthquakes.

Advanced End-users: You can specify two threshold parameters, which must all be
exceeded before an event message received by the EEWDisplay will be displayed as
an alert. Thus, the parameters you set here will control the number of alert
messages you will receive. Earthquake magnitude represents the amount of energy
released and depends on the surface area of the rupture. Seismic intensity is the
amount of shaking, and is a relevant measure for potential damage. The seismic
intensity value the end-user sets will filter out all alerts that are below that value
for the end-users chosen lat/long settings, not for the earthquake as a whole.

▪ Minimum Magnitude: Enter the minimum magnitude of events for which you
will receive alerts. Take care in setting this value. The ShakeAlert system is
currently set to issue ShakeAlert Messages for events with magnitudes “3.5” or
above. These smaller events are not damaging, but can be used to test the
system. If you set the minimum magnitude too high (e.g., “5.5”), you may not see
any ShakeAlert-powered alerts in the following weeks or months. We encourage
you to try different magnitude thresholds.  During the evaluation period, we
prefer that you use a small value (e.g. “3.5” to receive all ShakeAlert-powered
alerts).

▪ Minimum Intensity: Enter the minimum seismic intensity (MMI scale) to be
expected at your location for which you want Shakealert-powered alerts. The
scale, shown on the lower left of the EEWDisplay screen, ranges from “1” (not
felt) to “10” (extreme shaking). Bear in mind that you will not receive alerts if
you set the threshold too high. Start with a small value (e.g., “1.0” to receive all
ShakeAlert-powered alerts).

o Audio Settings: These allow the end-user some control over the audio alert that will
be played when an event message is received or at startup.
▪ Checkbox for Test Audio at Startup: when checked a short audio clip (chirp by

default) will play at startup to test audio is working.
▪ Checkbox for Alert Tones: when checked the alert tone (a bell or siren sound)

will be played during an alert.
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▪ Checkbox for Verbal Countdown: when checked announcements will be played
during an alert, giving shaking level expected at your location, and number of
seconds estimated until strong shaking arrives.

▪ Checkbox for Custom Announcement: when checked a custom announcement
will be played during an alert, which gives the end-user basic instruction that an
earthquake is occurring and protective action should be taken.

▪ Checkbox for Mute at Startup: when checked this enables the ‘Mute’ feature
automatically at startup, which will silence all incoming and simulated alerts.
The ‘Mute’ can be disabled at any time by unchecking the box on the Button Bar.

o Advanced Settings: Note that changes to these parameters will require a restart of
the EEWDisplay program to take effect. These settings control connections to alert
and time servers.
▪ ShakeAlert Server List: Default values will be input here, e.g., the ShakeAlert

servers running at the different ShakeAlert system processing centers. A
drop-down list will show the servers currently being used. The Add, Edit and
Remove buttons can be used to add, edit or remove ShakeAlert servers. The
Default Servers button will restore the list of default servers. Do not change
these unless instructed to do so.

▪ ShakeAlert Port: A default value will be inputted here automatically, e.g., port
61617 (or 443) for connection to the ShakeAlert server, and port 123 UDP for
NTP server. Do not change these unless instructed to do so.

▪ Checkbox for Randomize Connections: This controls the order that the
EEWDisplay program will attempt to connect to the ShakeAlert servers. Leave
this at its default status, which is checked.

▪ Checkbox for Show Detailed Server Status: It is recommended to not change
this setting. The ShakeAlert system status box shows the time and data servers
being accessed, as well as any error messages. It also shows a latency value in
seconds, which is the difference between the ShakeAlert system send time and
your EEWDisplay’s receive time for the last message. The default view is a
summary of each component; checking this box expands the view to show each
instance of each component.

▪ ShakeAlert Message Topic: radio buttons allow the end-user to switch between
receiving standard ShakeAlert-powered alerts (containing earthquake source
parameters such as origin time, magnitude and location (epicenter and finite
fault if available)), contour messages (standard information plus ground motion
contours), or map messages (standard information plus ground motion maps).
Advanced (pilot program) end-users can enter a topic name in the Custom text box
if they know the full description. Do not use this option unless arrangements have
been made in advance.

▪ Checkbox for time server Synchronize: If there are problems with your
EEWDisplay connecting to the specified NTP server, checking this box will switch
the program to using the local system clock on your computer instead. Do not
uncheck this box unless you are certain that your computer clock is correct,
otherwise warning times will be incorrect or alerts may be missed.
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▪ NTP Server Name: It is recommended to not change this setting. An alternative
NTP server address may be specified.

▪ TrustStore File Path and Password: Most end-users should not need these
settings. End-users participating in pilot programs may be sent a trust store file
and details should be entered here. The file button launches a pop-up to navigate
the file system to the correct file.

▪ Checkbox to Show Password in plain text.

Notes:
○ Changes to parameters marked with an asterisk including graphics, Server Name, or

Port will cause a dialog box to appear informing the end-user that a restart is required
for changes to take effect. Without auto-login enabled, a restart will re-check
credentials.

○ The Default button can be used to restore the default settings.
○ If you edit any of these settings, click OK. Click Cancel to discard changed settings you

decide you do not want enabled.
○ The Default All button will set all values in the dialog to their default settings.

● Layers launches a dialog to edit the layers visible in the main EEWDisplay window, such
as displays of roads and towns, and event features such as P and S wavefronts. This
gives the end-user greater control to switch both map and event features on and off in
their display. N.B Enabling many map layers increases the graphics processing
requirements. If you notice delays or stuttering in map rendering, try reducing the number
of map layers enabled.
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Seismic Information

Event Info Shaking intensity banner, event information panel, star
showing epicenter location, status information.

Event waves P and S wavefronts displayed as yellow and red circles.

Rupture Location Shows finite fault rupture

Intensity map Displays the seismic intensity provided in the ground
motion map message as a coarse grid when subscribing
to the Contour topic. Color is from the Modified Mercalli
Intensity Scale (MMI).

Intensity contour Displays the seismic intensity polygons provided in the
ground motion contour message, which are simple
8-vertex polygons when subscribing to the map topic.
Color is from the Modified Mercalli Intensity Scale
(MMI).
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Event History Recent events (live and replayed) are shown as squares,
colored by age and sized by magnitude. Events can be
replayed by double-clicking.

o Red: less than one hour
o Blue: less than one day
o Yellow: less than 7 days
o Grey: more than 7 days

Ground Motion Symbols Shows station ground motion observations. They are
shown colored by shaking intensity with symbols
denoting prediction or observation, and differentiating
between displacement, velocity and acceleration.

Stations Network stations contributing data to the earthquake
early warning system. Note that symbols (small yellow
triangles) will only be visible at higher zoom levels.

Legends MMI intensity scale, disclaimer.

Typical Blind Zone Region around the end-user’s location denoting the
zone where, if an earthquake were to start there, the
end-user would likely have a zero warning time.

Map Features

Towns Markers and names, scaled by population.

CA faults Fault traces shown as thin grey lines.

WC roads Shown as orange lines.

WC faults Fault traces shown as thin grey lines.

WC streams Blue lines.

WC lakes Blue regions.

WC urban centers Pink shading showing major urban centers.

PNW tectonic Plate boundaries marked in white (includes San
Andreas in California).

PNW volcanoes Marked and labelled.

CA counties Boundaries shown as black lines.

WC states Shows California, Oregon and Washington state areas as
white regions.

Political boundaries Shows global landmasses as blue regions with black
country borders.
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Background Changes the background to a gradient blue from top to
bottom.

Notes:
○ Only visible layer selections made by the end-user are persistent through a program

restart. Controls are present for other end-user modifications: arrows for layer
re-ordering, plus/minus buttons for adding or removing layers, edit option for each layer.
We do not describe them further here as we suggest the end-user should not make
use of these features in this EEWDisplay version. Any changes made would not be
persistent though a program restart, and would need to be made each time the program is
launched.

○ The vertical arrangement of names in the Layers dialog window represents their relative
hierarchy on the display map. The mapping engine will draw the layers at the top of the
list after drawing those at the bottom, so layers at the top of this list will be visible ‘above’
layers at the bottom. The end-user should beware of this behavior if moving large area
layers (e.g. WC states) to the top of the list.

View
Change or refresh your display using the selections here.

● Reset Map changes your view of the map back to your preferred settings (see
Settings panel). You can also use the keyboard shortcut Ctrl-L.

● Clear Display clears all alerts and other icons from the map. You can also use the
keyboard shortcut Ctrl-D.

● Toggle FullScreen opens your program window to fill the screen (FullScreen) or, by
clicking again, returns it to a smaller window. You can also use the keyboard
shortcut Ctrl-F.

● Show Status opens the ShakeAlert Status box, showing the time and data servers
being accessed, as well as any error messages. It also shows a latency value in
seconds, which is the difference between the ShakeAlert system send time and your
EEWDisplay’s receive time for the last message. You can launch this same box by
double-clicking the Status Indicator light (the box that should be Green when
properly connected) on the Button bar.

● Show Log opens a window and displays log messages.
● Load Recent History loads the most recent events from the end-user’s history folder

into the history layer for easier replay. Up to 30 events will be shown. Events are
shown as boxes colored by time. Since a number of events may have occurred at the
same, or close, geographic locations, clicking on any event in the example or history
layer will launch a pop-up menu listing the available events to play (figure below).
Events are listed using their event ID (for events received in real-time this may
include the date and time), magnitude, nearest city, and the number of updates in
the sequence. Clicking on any event in the pop-up menu begins the replay.
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● Clear Recent History removes recent history events from the history layer.
● Load Examples offers a sub-menu of standard, contour, map, or all, which determines

whether the loaded example messages will contain ground motion information.
Selecting one of these will load example events into the history layer for easier
replay. Events are shown as boxes colored by time. Since all example events are old,
they will appear as grey boxes. Note that if the end-user wishes to add further
examples, they must be placed in the replay_data directory. Alternatively, if the
end-user wishes to keep new examples in a separate folder, the ExamplesDir in the
app.properties file can be added or edited to provide a full comma-delimited list of
replay directories, e.g.:
ExamplesDir=replay_data/ShakeAlert_examples,replay_data/My_examples

● Clear Examples removes example events from the history layer.
● Show Legend launches a pop-up containing a legend for the symbols and scales

shown on the map (see below). This includes the event symbols, their size and
color-scaling, the MMI (intensity) color scale and other symbols that appear on the
map such as site ground motion observations or recording stations.
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Help
View documentation about ShakeAlert, including version details, copyright, end-user
license agreements, and end-user guide link, and also access “Check for Updates” feature.
■ Readme displays EEWDisplay README file. Note that this file contains useful reference

information such as default server addresses and program configuration.
■ Changes displays EEWDisplay Changes file. Note that this file contains information on

bug fixes and new features available with different versions.
■ User Guide opens a pdf of the EEWDisplay user guide. If a newer version of the

document is available online, it will be downloaded and then opened as a pdf.
■ Evaluation License Agreement opens a pdf of the Evaluation License Agreement. If a

newer version of the document is available online, it will be downloaded and then
opened as a pdf.

■ Check for Updates has the program check for any pending updates to the interface.

Button Bar

● Power-off icon. Clicking this icon will terminate the EEWDisplay program. You will not
get any more alerts until you restart the EEWDisplay program.

● Program Status Light. Click or hover cursor over the status light square, to the right of
the Power icon, for information regarding connection status.

Green: The communication between the ShakeAlert system and your
EEWDisplay is healthy. You will be able to receive alert messages.

Grey: There is no communication between the ShakeAlert system and your
EEWDisplay. This may occur briefly at start-up or during reconnection

attempts. If this status persists (several minutes) the end-user should check internet
connection and then try using the ‘Reconnect to ShakeAlert server’ option in the
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EEWDisplay menu. If the issue does not resolve, the User should exit the program
and restart.

Yellow: The ShakeAlert system is only partially operational or there is a
connection problem to the Network Time Server. You are likely to receive

alert messages. If an ‘NTP Error’ is showing, try reconnecting to the time server
(EEWDisplay menu > Reconnect to Time server).

Cyan: EEWDisplay connections have been disabled. If this is seen, the
end-user should restart the program.

Red: There is a connection problem to either the ShakeAlert servers, or the
EEWDisplay program is unable to synchronize with a Network Time Server.

Make sure your computer has a working Internet connection and that no firewalls
are blocking that connection. Try reconnecting to the time server (EEWDisplay
menu > Reconnect to Time server).

Problems connecting to the Network Time Server (NTP) are reflected in the color of
the program status light, as well as connection issues for receipt of ShakeAlert
Messages. If the status light is yellow or red and an “NTP Error” is identified, this can
lead the event info panel on the left to report incorrect warning times. NTP status
messages are also included in the main log accessible within the program (from the
top Menu bar, click View > Log). If errors with specific components of the ShakeAlert
servers are indicated the end-user does not need to take any action.

● Settings button opens the Settings dialog box; for details, see Top Menu Bar > Edit >
Settings.

● Play Event button is the same as selecting from the Top Menu Bar, Replay > Play Event,
and launches the Select Event dialog box so you can choose a past event to replay.

Advanced End-users: XML-messages from the ShakeAlert system that have been received
by the EEWDisplay (while connected to power and internet) will be stored on your
computer in the “history” folder. When you click on the "Play Event" button, an open-file
dialog appears. You may click on one of the subfolders (within the history folder the name
of the subfolders indicates the ShakeAlert eventID; note that this id is different from the
eventID that is used in ShakeMap for instance) and replay an event by double-clicking on
the file with the “.eew” extension. The event will not be displayed, if the threshold
parameters in “Settings” are not exceeded, or if the warning time is zero or negative.

Starting with release v2.4, the EEWDisplay is capable of processing and displaying finite
fault ruptures and the estimated slip along these ruptures. This feature improves intensity
estimates at the end-user’s site for large earthquakes (M>6.5). To get more familiar with
the finite fault capabilities of the EEWDisplay, we recommend replaying the examples from
the “examples” folder. You will find examples for a number of scenario earthquakes in
folders “SYN_”. Click on the .eew file to start the corresponding animation. For scenarios in
the “SYN_” folder, the grey line shows the estimated rupture of the earthquake. The
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EEWDisplay will use the closest distance between the rupture and your site to calculate
the expected intensity that you would feel if this event were real.

● Acknowledge button will act on the current event to prevent the EEWDisplay from
popping-up and grabbing screen focus for event updates. The EEWDisplay will continue
to receive and log the updates, so they will be available for replays, and audio-visuals
will continue to update in the background.

● Silence button quiets a current alert. You can also use the keyboard shortcut Ctrl-S.
This feature mutes ONGOING alerts, for example to suppress audio alerts for distant
earthquakes with long warning times that may be irrelevant to the end-user.

● Mute checkbox will silence all incoming and simulated alert. You can also mute alerts
with the keyboard shortcut Ctrl-M. The “mute” button is useful to silence the
EEWDisplay during a large aftershock sequence after a strong earthquake.

Top of Program Status/Shortcuts

Hover your cursor over the EEWDisplay icon at the top of your computer window (or
wherever your taskbar or dock is located) to view the EEWDisplay version number, current
date and time, and current connection status to the ShakeAlert servers. The color of the
icon shows the EEWDisplay status (see the Program Status Light section for explanation
of color codes).

Some caveats:
● Linux end-users have reported that the resulting status message does not wrap

properly.
● Windows end-users will find the EEWDisplay icon in their Notification Area (see Figure

4). Click the up-arrow on your task bar to open the Notification Area.
● Windows end-users can customize the system tray so the EEWDisplay icon is always

visible in the task bar. Right-click the task bar, select Properties, and click
“Customize…”; on next screen, choose “Show icon and notifications” for EEWDisplay
(JavaTM Platform).

If you click once (Mac) or right-click (Windows/Linux) on the EEWDisplay icon, you will get
information on the running version and properties file plus three shortcuts for the
program:
Settings: Displays the Settings dialog box
Show: Brings the EEWDisplay program from a minimized state
Exit: Exits or shuts down EEWDisplay
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Minimize/Maximize and Close the EEWDisplay Window

Standard operation of EEWDisplay is to close the window using the ‘Close Window’ button.
This will ensure that the EEWDisplay will still be running and will pop up automatically
when an event alert is received that meets the User’s alert criteria. The status icon on your
taskbar or dock is the indication that EEWDisplay is still running. Minimizing the window
will lead to the same behavior. (Click the Power Off icon on the Button Bar to terminate the
program completely.)

Map Navigation

The navigation buttons allow you to move around on the EEWDisplay.

● Pan: This button on the far left, when its arrows are clicked, allows you to pan east,
west, north, south (horizontal and vertical arrows), as well as northeast, northwest,
southwest, and southeast (corner arrows). Click the center of this icon to center the
state of California in your window.

● Zoom: Click the Plus magnifying glass to zoom into the display, and the Minus
magnifying glass to zoom out.

● Select: Change your cursor to a selector, e.g., to click buttons, select events for replay.
● Area Zoom/Move: Click on the button to use mouse clicks and drags to control map

positioning. Clicking on the top, bottom or sides of the map area will move the map in
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the desired direction. Clicking and holding the left mouse button allows the end-user to
drag to select a desired map area. The area is centered on the position of the mouse
click.

● Drag: Click on the hand and then click-hold on the screen, to drag the display to where
you wish.

● Edit Layers: Click on the Layers button to launch a dialog to edit the layers visible in the
main EEWDisplay window, such as displays of roads and towns, and event features such
as P and S wavefronts. This gives the end-user greater control to switch both map and
event features on and off in their display. Further details can be found in the section Top
Menu Bar > View > Edit Layers.

● Zoom level: Edit the zoom level scaling manually.

A shortcut for setting your current location is also available from the map: a right-click (or
two-finger click on Mac) launches a menu of ‘Location options’. The first option is to ‘Set
home location’ to the location of your mouse/cursor.  The next option is to save the current
view and zoom factor as your default at startup.  The last option is to create a custom event
at this location.

When moving the cursor across the map, the lat/lon values will be displayed in the lower left
corner. The zoom level is displayed in a text box near the top in the navigation bar just below
the "Play Event" button.
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4. Alert Information
When the EEWDisplay receives an XML ShakeAlert Messages  message from the ShakeAlert,
the following information will be displayed (provided that your thresholds in “Settings” are
exceeded and the remaining warning time is greater than 1 second:

The following symbols appear on the map after an event occurs:
● Red star – Location of current event
● Thick grey line – Finite fault rupture (only visible if an algorithm that calculates finite

fault reports for the event)
● Yellow triangles (pointed up) – Approximate location of earthquake sensing station(s)
● Ground motion symbols, color coded by MMI at each location. If an algorithm has

reported ground motion information for a particular station location, a color-coded
symbol will appear, and if the cursor is hovered over the symbol information on the
station code and ground motion value will be given. See the legend for which symbol
represents which type of ground motion.

● Ground motion contours or maps - Polygons or grids color-coded by MMI for predicted
shaking intensities (see screen captures below). These will appear if EEWDisplay is
configured to receive the contour or map message topic.

● Follow-up information reflects the results of Human Review of the ShakeAlert Message.
ShakeAlert Duty Review Team follow-up information will be displayed on the map in a
grey box in the upper right. The end-user could receive a  ‘follow-up’ message indicating
a human review result of:
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o Successful Alert: A ShakeAlert Message was issued and the alert delivered to
EEWDisplay had a reasonable location and magnitude.

o Inaccurate Alert: USGS issued a ShakeAlert Message for a real earthquake, but the
ShakeAlert system misjudged the location and/or magnitude. The alert delivered to
EEWDisplay has inaccuracies.

o Cancelled Alert: The USGS issued a  ShakeAlert Message when the event posed little
or no ground shaking hazard or there was no earthquake at all. The alert delivered
to EEWDisplay was cancelled.

o Missed Alert:  An acknowledgement message that a significant earthquake occurred
but no ShakeAlert Message was issued by the USGS resulting in no
ShakeAlert-powered alert delivery to EEWDisplay. Earthquake parameters of the
message are imported from an Advanced National Seismic System (ANSS) network
solution.

A. Map: Your location is shown by a blue house, and the estimated location of the
earthquake by a red star (and/or a thick grey line if a finite fault solution is
displayed). The map is automatically centered on a point halfway between the two
locations. The yellow and red radiating circles show the estimated locations of the P
and S wavefronts of the earthquake, respectively.
P-waves, which travel faster than S-waves, rarely cause damage because amplitudes
are smaller and ground motions are predominantly in the vertical direction. The
yellow circle, representing the P-wavefront at a given time, will always be larger than
the red circle (S-wavefront). Damage is typically caused by S-waves.
The “remaining time” is the estimated time it will take for the S-wavefront (red
circle) to reach your location. For some events you will also see estimated or
observed ground motions at various sites shown by filled inverted triangles or
circles respectively.
The map will also display information on a banner in the upper center of the map:
● “Server Warning” - ShakeAlert server is running but there are some issues. No

end-user action is required.
● “Server Error” - ShakeAlert server error. No end-user action is required.
● “System Offline” - Connections are disabled. end-user should restart the

program.
● “No NTP Connection” - Problem trying to synchronize with the NTP server.

end-user should check internet connection. If the warning remains after a few
minutes, end-user should try forcing ‘Reconnect to Time server’ from the
EEWDisplay menu. If the warning persists and the end-user’s computer clock is
accurate, then consider disabling ‘Synchronize’ by unchecking the box on the
Settings panel under Advanced Settings > Time Server Parameters.

● “No Connection” - No connection to the ShakeAlert servers can be established.
After 1 minute the end-user should try forcing a ‘Reconnect to ShakeAlert server’
from the EEWDisplay menu, or a restart of the program.

● “Connection Pending” - Connection to ShakeAlert servers is being established. No
end-user action is required unless the message persists beyond several minutes.
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● “Program Error” - Unclassified errors. end-user should restart the program. If the
error persists, the end-user should try re-installing the program.

● “Audio Unavailable” - There was an error initializing audio.
● “Audio Muted” - Mute checkbox is selected, click it to toggle.
● “Audio Silenced” - Audio has been disabled for the current event using the Silence

button.
● “Audio Filtered” - Current alert has parameters below thresholds set in the Audio

Threshold section of the Settings panel.
● “Playback” - Event shown on the map is a replay.
● “Alert Cancelled” -  The duty reviewer cancelled the current alert by ShakeAlert

system.
● “This is a Test” - Current alert is a test event sent by a ShakeAlert server.
You may notice a grey circle around your location. This approximates the area
where, if an earthquake starts within this region, EEWDisplay is extremely unlikely
to deliver an alert before shaking arrives. If an earthquake occurs within this area,
you will likely experience the shaking before you could receive an alert. We are
working to decrease the radius of this area in future versions of the ShakeAlert
system.

B. Information Panel: The panel on the left side of the screen gives the estimated time
(in seconds) remaining until shaking is expected to begin at your location, the
estimated seismic intensity on the Modified Mercalli Intensity (MMI) scale, and the
estimated magnitude. The Information Panel also gives the Probability of  Successful
Alert  (PCA); we have introduced three PCA levels: “low”, “moderate”, and “high”. The
top section of the panel gives event ID, estimated event origin time and epicenter.

C. Top Panel: the top panel describes the level of expected shaking at your location  (in
words and in color), e.g. “Light Shaking Expected”.

27



Finite fault detection capability of EEWDisplay. Thick grey line shows extent of current fault rupture.

Ground motion message contour display in EEWDisplay. Contours are colored by intensity scale shown.
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Ground motion message map display in EEWDisplay. Grid points are colored by intensity scale shown.

Expected MMI level will be shown on the map and in the lower right for the current cursor position when either
map or contour messages are displayed.
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If a follow-up Message is published  by the ShakeAlert system, it will be shown on the map, giving both the type of
follow-up and any text sent with the message.

Important: Do not forget to turn on the volume of your computer, and do not check the
“mute” box at the top of your EEWDisplay if you want to hear alerts (siren and voice
announcement).

This Operations Guide was written by M. Böse and J. Andrews (Caltech), with project
overview and installation instructions provided by members of the ShakeAlert Joint
Committee for Communication, Education, Outreach, and Technical Engagement (JCCEO &
TE), and with input from past and present members of the ShakeAlert team members from
the following institutions: UC Berkeley, California Institute of Technology (Caltech), ETH
Zurich, USC/SCEC, US Geological Survey.
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5. Contact information
For questions or feedback please contact:

Southern
California

Margaret Vinci
(Caltech)

mvinci@gps.caltech.edu 626-395-3298

Northern
California

Jennifer Strauss
(UC Berkeley)

Tal Edgecomb
(UC Berkeley)

jastrauss@berkeley.edu

​​tale@berkeley.edu

510-642-1067

Oregon Lucy Walsh
(University of Oregon)

lwalsh@uoregon.edu 541-346-4654

Washington Bill Steele
(University of Washington)

wsteele@uw.edu 206-685-5880

Washington
& Oregon

Gabriel Lotto
(University of Washington)

glotto@uw.edu

USGS Robert de Groot
(USGS)

rdegroot@usgs.gov 626-583-7225

Additional information on the ShakeAlert Project can be found at
https://www.shakealert.org. Thank you very much for your participation. We are looking
forward to your feedback.
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6. Troubleshooting
You may encounter one or more of the following issues when running the EEWDisplay:

1) Problem:  Warning time is excessive for location of epicenter

Solution: Check the computer’s internal clock. If the computer’s clock is incorrect, it
will adversely affect the accuracy of warning time. Verify the connection to the NTP
server to obtain correct time information.

2) Problem: EEWDisplay did not record recent events in your absence.

Solution: Turn off “sleep mode” on your computer.

3) Problem: Computer slow to respond or locks up when EEWDisplay is running.

Solution: Computer resources are insufficient to run the EEWDisplay. Close
non-essential applications.

4) Problem: Not receiving email notices about planned ShakeAlert system tests, etc.

Solution: Make sure your correct contact information is in our database. Contact your
ShakeAlert Technical Engagement Regional Coordinator as listed in the Contact
Information Section.

5) Problem: Gray circle around Home does not update when location is changed in
settings window.

Solution: Force a redraw of the main window by changing the zoom level or pan the
display around. Note that the grey zone is only an estimate. It is not used for any
calculations within the EEWDisplay.

6) Problem: What do the different status colors mean: green, grey, yellow, cyan or red?

Solution: Click or hover cursor over the status box for information regarding
connection. See the section Button Bar > Program Status Light for detailed descriptions
of status light.

7) Problem: “CONNECTION PENDING” appears in red on map, status may be any color.

Solution: No connection yet. If the problem does not resolve itself within a few minutes,
check your Internet connection.

8) Problem: “NO CONNECTION” appears in red on map, status may be any color.

Solution: No connection to ShakeAlert server.  Make sure the computer has access to
the internet.  Check ShakeAlert server and port settings.  See README file for list of
servers and ports.  If there is a connection problem and the problem does not resolve
after several minutes, you can use the EEWDisplay > Reconnect to ShakeAlert server
menu item to try re-establishing your connection.
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Instead of the default port 61617, you could try using port 443 in the Settings dialog.
You will need to restart the program after making any changes to the server settings.

9) Problem: “NO NTP CONNECTION” appears in red on map, status may be any color,
pop-up text says “NTP ERROR”.

Solution: Problem connecting to NTP server.  Note that it may take several minutes for
this to update. If the problem does not resolve after several minutes, you can use the
EEWDisplay > Reconnect to ShakeAlert server menu item to try re-establishing your
connection.

Alternative settings for the NTP server can be configured using the NTP Server Name
field in the Settings dialog, launched from Settings button or Edit > Settings menu
option. The default NTP server is currently set to us.pool.ntp.org. Try changing to other
NTP servers such as time.nist.gov or ntp-01.caltech.edu. Each time you change the NTP
server you will need to exit the EEWDisplay program (EEWDisplay > Exit or the red
‘power off’’ icon on the left of the button bar) and restart the program.

If problems connecting to NTP servers are persistent, the EEWDisplay can be switched
to using the clock on the end-user’s computer by unchecking the ‘Synchronize’ box on
the Settings dialog, under Advanced Settings > Time Server Parameters. The end-user
should be certain that the computer clock is accurate, otherwise warning times will be
incorrect or alerts may be missed.

10)Problem: “SYSTEM OFFLINE” appears in red on map and status may be any color.

Solution: Unless you just tried to change the NTP connection, there may be a problem
with one of the ShakeAlert servers.  If the problem does not resolve itself in a few
minutes you could try to force a reconnect using EEWDisplay > Reconnect to ShakeAlert
server or quit and restart the program.  It may take several minutes for the status to
refresh while the program is trying to reconnect.

11)Problem: There are no events in my history folder to select for replay.

Solution: When the software is first downloaded there will be no events in the history
folder. This is where alerts are stored that have been received by the EEWDisplay while
it has been running. See the README file in your installation directory for instructions
on how to copy old history files from a previous version.

12)Problem: Error message appears with the message that you cannot connect to the
ShakeAlert server. This is most likely due to your institution’s restrictions on port access
through firewalls for example.

Solution: Launch the Settings dialog using the button on the button bar and change the
port number from the default 61617 to 443. Press OK, exit the EEWDisplay and restart.

13)Problem: When I double-click on the EEWDisplay launch icon nothing appears, I do not
see the EEWDisplay splash logo.
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Solution: There is likely a problem with the java installation and the EEWDisplay
program cannot be launched. Try re-installing java.

14)Problem: When I double-click on the EEWDisplay launch icon I do see the  EEWDisplay
splash logo but the program does not start.

Solution: There is likely a problem with the EEWDisplay installation. Try reinstalling
EEWDisplay.

15)Problem: When launching EEWDisplay I get an error pop-up dialog saying there is a file
missing or problem copying a file.

Solution: There is likely a problem with the EEWDisplay installation. Try reinstalling
the EEWDisplay program.

16)Problem: When launching EEWDisplay I get a warning pop-up dialog saying there is a
newer configuration file available, would you like to replace.

Solution: Select ‘Yes’ to use the new file and a backup copy of your old file will be made
should you want to revert (by manually replacing the new file with the old in your local
directory). Select ‘No’ to use your existing file but note you will be prompted at each
program re-start.

17)Problem: The Auto Login checkbox keeps getting cleared and I have to manually login.

Solution: Any changes to the ShakeAlert server list, port, alert topic, NTP settings will
automatically deselect the Auto Login checkbox in case there is a problem reconnecting.
Once the new settings are confirmed you can re-enable auto login.

18)Problem: EEWDisplay text looks too small on high resolution monitors.

Solution: In the Settings Panel, try using a slightly larger value for HDPI Font Size
Multiplier.  The default is 1, increment by .5 at a time.  You will need to restart the
program for the change to take effect.  Note if you set it too large then you might not be
able to change it back if the OK button does not fit on the screen.  If this happens, quit
the program, delete your app.properties file and restart the program.

On Windows you can try also try the following:
Right mouse on the desktop shortcut, select properties. On the new dialog select
Compatibilty then under Settings at the bottom select “Change high DPI
settings''.  Check “Override high DPI scaling behavior.  Scaling performed by
Application''.  Hit OK and restart the program.
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7. Known Issues

1) Issue: The EEWDisplay flickers, is incompletely redrawn, and/or the audio is uneven
during an earthquake alert.

This is a known problem with Java 8 update 121, which was released January 17, 2017.
It does not affect all computers but appears to be particularly worse on Windows.
Previous versions of the EEWDisplay may also be affected by the recent java updates.
Reverting to versions of Java 8 prior to 101 should improve the display or upgrade to a
more recent version.   As of July 2021, the most recent version of Java 8 is update 301.  It
may also help to disable some of the more detailed map layers.

2) Issue: EEWDisplay does not always recover from an incorrect server/port combination.
Using EEWDisplay menu options to reconnect does not always work.

Confirm valid connection to the Internet. Correct server and port entries and restart
program.

8. Example Event Directory
Example events are made available for replay to demonstrate ShakeAlert-powered alerts
delivered to the end-user featuring the audio and visuals of the EEWDisplay program.
Examples include events in different geographic regions and at different magnitudes, as
well as ShakeAlert-powered follow-up alerts delivered to the end-user: cancellation,
inaccurate, and missed.  Additional events could be added to the Scenario Server in the
future.  Scenario Server events have four categories:

Actual - Events that have previously been detected during actual ShakeAlert operation.
Special - Events and Messages that illustrate peculiar or unusual aspects of the ShakeAlert
Message set.
Historical - Historical events known from network archives that occurred within the
ShakeAlert operational region. For most events, seismic data have been drawn from the
archives, then replayed through ShakeAlert software to develop Messages.
Scenario - Imagined possible large earthquakes. Thankfully, the largest earthquakes are
rare. Scenario category events help fill in the gaps where locations or magnitudes of real
events have not been recorded.

Actual Events

ElMonte_20200919 = Actual, M4.5 El Monte (east LA)
Event ID: M4.5 El Monte (east LA)
Description: Deep (18 km), under east LA , 2020-09-19; with update messages, follow-up
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Magnitude: M4.5; Location: 34.07, -118.09; Depth: 18 km
Event Notes: Felt throughout LA.  Ex. moderate eqk in densely populated area.  Ex. alert
before S-wave reaches surface. follow-up realistic at at 348 s

Westmoreland = Actual, M4.6 Westmoreland
Event ID: M4.6 Westmoreland
Description: Westmoreland (S. Imperial Valley), 2020-10-01; with update messages,
follow-up
Magnitude: M4.6; Location: 33.04, -115.6; Depth: 8 km
Event Notes: ShakeAlert peak magnitude >5.0; WEA triggered.  follow-up realistic at 173s

TCEVENTS/RidgecrestM7.1 = Actual, M7.1 Ridgecrest, mainshock
Event ID: M7.1 Ridgecrest, mainshock
Description: Eastern California, 2019-07-06, long rupture, finite-fault solution, with
updates
Magnitude: M7.1; Location: 35.77, -117.62; Depth: 9 km
Event Notes: Widely felt in Los Angeles 200 km from epicenter; magnitude increases with
time; event time = time of T&C rerun; "T&C" = Test and Certification, indicates an event
with seismic data used to test ShakeAlert software

TCEVENTS/RidgecrestM6.4 = Actual, M6.4 Ridgecrest, foreshock
Event ID: M6.4 Ridgecrest, foreshock
Description: Eastern California, 2019-07-04, with updates, finite-fault solution, no
follow-up
Magnitude: M6.4; Location: 35.77, -117.62; Depth: 9 km
Event Notes: Widely felt in north Los Angeles 200 km from epicenter; magnitude updates
with time.  Event time = time of T&C rerun

TCEVENTS/RidgecrestM5.5 = Actual, M5.5 Ridgecrest aftershock
Event ID: M5.5 Ridgecrest aftershock
Description: Eastern California, 2019-07-05, with updates, no followup
Magnitude: M5.5; Location: 35.77, -117.62; Depth: 9 km
Event Notes: Large aftershock of M6.4; event time = time of T&C test

TCEVENTS/RidgecrestM5Foreshock = Actual, M5.0 Ridgecrest foreshock
Event ID: M5.0 Ridgecrest foreshock
Description: Eastern California, 2019-07-06, near foreshock to M7.1; with updates, no
follow-up
Magnitude: M5.0; Location: 35.77, -117.62; Depth: 9 km
Event Notes: Foreshock minutes before Ridgecrest M7.1; event time = time of T&C test

Seattle = Actual, M4.6 Seattle-area
Event ID: M4.6 Seattle-area
Description: Moderate Seattle-area event, 2019-07-12; with update messages
Magnitude: M4.6; Location: 47.89, -121.97; Depth: 9 km
Event Notes: Widely felt
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Special Events

ForeMain = Special, Foreshock/Mainshock
Event ID: Foreshock/Mainshock
Description: foreshock-main shock event pair, both with updates; actual event pair
Magnitude: M4.0, 4.9; Location: 34.07, -118.09; Depth: 18 km
Event Notes: Foreshock-mainshock pair.  foreshock 26 s. before main; updates interleave -
last update of foreshock comes in middle of mainshock updates.

NMexico = Special, M5.5 N Mexico
Event ID: M5.5 N Mexico
Description: 2020-03-07; south of border, with updates
Magnitude: M5.5; Location: 31.74, -114.58; Depth: 8 km
Event Notes: Event in Mexico; ShakeAlert contours reach inside US

Ferndale = Special, M5.1 Ferndale
Event ID: M5.1 Ferndale
Description: 2020-03-18; Moderate event near shore, with updates
Magnitude: M5.1; Location: 40.42, -124.24; Depth: 9 km
Event Notes: ShakeAlert inflates magnitude, moves event far offshore

FerndaleM3 = Special, M3.0 Ferndale
Event ID: M3.0 Ferndale
Description: 2020-11-02; Small event off NW California; with updates and qualified
follow-up at 30s
Magnitude: M3.0; Location: 40.29, -124.63; Depth: 8 km
Event Notes: ShakeAlert inflated magnitude, moves event far offshore with large M, outside
alert boundary; then back near shore with reasonable magnitude

Point_Source/missed_20200309 = Special, M5.9 Mendocino
Event ID: M5.9 Mendocino
Description: 2020-03-09; Missed alert example
Magnitude: M5.9; Location: 40.39, -125.09; Depth: 3.2 km
Event Notes: ShakeAlert located outside alert boundary; no alert sent.  Actual event near
shore, felt

FalseAlertFollowUp_M4.6 = Special, M4.6 Salton Sea false alert
Event ID: M4.6 Salton Sea false alert
Description: False alert with update and follow-up
Magnitude: M4.6; Location: 33.24, -115.7; Depth: 8 km
Event Notes: Example false alert, magnitude to trigger apps, with one update before ending;
with follow-up message  at 25s. Realistic delay to follow-up would be 300-600s.

FalseAlertFollowUp_M5.2 = Special, M5.2 Salton Sea false alert
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Event ID: M5.2 Salton Sea false alert
Description: False alert with updates and follow-up
Magnitude: M5.2; Location: 33.24, -115.7; Depth: 8 km
Event Notes: Example M>5 false alert with three updates; with follow-up message at 25s.
Realistic delay to follow-up would be 300-600s.

Historical Events

TCEVENTS/AlumRock = Historical, M5.6 Alum Rock
Event ID: M5.6 Alum Rock
Description: South of San Jose, 2007-10-30, with updates, no follow-up
Magnitude: M5.6; Location: 37.43, -121.76; Depth: 9 km
Event Notes: Felt throughout South Bay region; event time=time of T&C test

TCEVENTS/Napa2014 = Historical, M6.0 South Napa
Event ID: M6.0 South Napa
Description: Napa Valley, NW of San Francisco, 2014-08-24, with updates, no follow-up
Magnitude: M6.0; Location: 38.21, -122.31; Depth: 9 km
Event Notes: Widely felt in North Bay; event time=time of T&C test

TCEVENTS/SanSimeon2003 = Historical, M6.5 San Simeon
Event ID: M6.5 San Simeon
Description: California central coast, 2003-12-22; with updates, no follow-up
Magnitude: M6.5; Location: 35.67, -121.12; Depth: 9 km
Event Notes: Widely felt; west of the San Andreas fault; event time=time of T&C test

Point_Source/1952_KernCounty_M7.3 = Historical, M7.3 Kern County
Event ID: M7.3 Kern County
Description: South of Bakersfield, 1952; point source, no updates
Magnitude: M7.3; Location: 35.00, -119.01; Depth: 10 km
Event Notes: Legacy scenario; largest instrumental era earthquake in SoCal; Intensity V in
downtown Los Angeles, widely felt.

TCEVENTS/ChinoHills2008 = Historical, M5.4 Chino Hills
Event ID: M5.4 Chino Hills
Description: East of Los Angeles, 2008; with updates, no follow-up
Magnitude: M5.4; Location: 33.953, -117.76; Depth: 5 km
Event Notes: Intensity IV in downtown Los Angeles; event time = time of T&C test

TCEVENTS/LaHabra2014 = Historical, M5.1 La Habra
Event ID: M5.1 La Habra
Description: East of Los Angeles, 2014; with updates, no follow-up
Magnitude: M5.1; Location: 33.932, -117.917; Depth: 4.8 km
Event Notes: Intensity III in downtown Los Angeles; event time = time of T&C test
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Point_Source/1994_Northridge_M6.7 = Historical, M6.7 Northridge
Event ID: M6.7 Northridge
Description: Northridge, 1994-01-17; north of Los Angeles; point source, no updates
Magnitude: M6.7; Location: 34.207, -118.535; Depth: 5 km
Event Notes: Legacy scenario; damaging; widely felt

Point_Source/1971_SanFernando_M6.6 = Historical, M6.6 San Fernando
Event ID: M6.6 San Fernando
Description: North San Fernando Valley, 1971; point source, no updates
Magnitude: M6.6; Location: 34.416, -118.37; Depth: 8.4 km
Event Notes: Legacy scenario;  Intensity VI in downtown Los Angeles

SYN_Imperial_M7.0 = Historical, M7.0 Imperial
Event ID: M7.0 Imperial
Description: Imperial fault, finite fault with updates
Magnitude: M7.0; Location: 32.52, -115.21; Depth: 10 km
Event Notes: Legacy scenario

TCEVENTS/HectorMine1999 = Historical, M7.2 Hector Mine
Event ID: M7.2 Hector Mine
Description: Desert northeast of San Bernardino, 1999; finite fault source, with updates, no
follow-up
Magnitude: M7.2; Location: 34.63, -116.3; Depth: 0 km
Event Notes: Intensity VII in downtown Los Angeles; event time = time of T&C test

TCEVENTS/Anza2013 = Historical, M4.7 Anza
Event ID: M4.7 Anza
Description: Mountains SE of Los Angeles, 2013; with updates, no follow-up
Magnitude: M4.7; Location: 33.5973, -116.5137; Depth: 9 km
Event Notes: Intensity VI in downtown Los Angeles; event time = time of T&C test

TCEVENTS/NISQUALLY_2001 = Historical, M6.8 Nisqually, WA
Event ID: M6.8 Nisqually, WA
Description: Deep Seattle-area, 2001; with update, no follow-up
Magnitude: M6.8; Location: 47.149, -122.727; Depth: 51.9 km
Event Notes: Intensity VIII in Olympia; event time = time of T&C test

TCEVENTS/COWLITZ_2006 = Historical, M4.5 Cowlitz Chimneys, WA
Event ID: M4.5 Cowlitz Chimneys, WA
Description: SE of Seattle, 20061008, with updates, no follow-up
Magnitude: M4.5; Location: 46.85, -121.6; Depth: 9 km
Event Notes: Cowlitz Chimneys, SE of Mt Hood; event time = time of T&C test

TCEVENTS/LEAVENWORTH_2013 = Historical, M4.0 Leavenworth, WA
Event ID: M4.0 Leavenworth, WA
Description: E of Seattle, 20130627, with updates, no follow-up
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Magnitude: M4.0; Location: 47.84, -120.64; Depth: 8 km
Event Notes: Central WA, east of Seattle; small crustal event; event time = time of T&C test

TCEVENTS/MT_ST_HELENS_2011 = Historical, M4.2 Mt St Helens, WA
Event ID: M4.2 Mt St Helens, WA
Description: S Washington, 20110214, with updates, no follow-up
Magnitude: M4.2; Location: 46.27, -122.2; Depth: 9 km
Event Notes: 90 km NNE of Portland; event time = time of T&C test

Point_Source/1993_ScottsMills_Oregon_M5.6 = Historical, M5.6 Scotts Mills, OR
Event ID: M5.6 Scotts Mills Oregon 1993
Description: Scotts Mills Oregon, 1993; point source, no updates
Magnitude: M5.6 Location: 45.035, -122.607; Depth: 19.6 km
Event Notes: New scenario

Point_Source/1993_KlamathFalls_Oregon_M6.0 = Historical, M6.0 Klamath Falls, OR
Event ID: M6.0 Klamath Falls Oregon 1993
Description: Klamath Falls Oregon, 1993; point source, no updates
Magnitude: M6.0; Location: 42.358, -122.058; Depth: 8.5 km
Event Notes: New scenario

TCEVENTS/OFF_OREGON1_2004 = Historical, M4.8 Off Oregon 2004
Event ID: M4.8 Off Oregon 2004
Description: Off shore Oregon, 20040712, with updates, no follow-up
Magnitude: M4.8; Location: 43.65, -126.48; Depth: 8 km
Event Notes: Offshore Oregon; event time = time of T&C test

TCEVENTS/OFF_OREGON2_2010 = Historical, M4.7 Off Oregon 2010
Event ID: M4.7 Off Oregon 2010
Description: Off central Oregon coast, 20100728, with updates, no follow-up
Magnitude: M4.7; Location: 43.65, -126.48; Depth: 8 km
Event Notes: offshore west of Eugene, OR; event time = time of T&C test

TCEVENTS/PUGET_2008 = Historical, M4.1 Puget 2008
Event ID: M4.1 Puget 2008
Description: Puget Sound, WA, 20080731, with updates, no follow-up
Magnitude: M4.1; Location: 48.13, -122.74; Depth: 8 km
Event Notes: NW of Everett, WA; example of mag growing into alert level; mag only greater
than 4.0 on 3rd update; event time = time of T&C test

TCEVENTS/VANCOUVER_2011 = Historical, M6.8 Vancouver Isl 2011
Event ID: M6.8 Vancouver Isl 2011
Description: West of Vancouver Isl, 20110909, with updates, no follow-up
Magnitude: M6.8; Location: 49.39, -127.15; Depth: 8 km
Event Notes: West offshore central Vancouver Isl., 280 km to Victoria, Canada; example
large earthquake NW of ShakeAlert boundary; initial M 6.2; event time = time of T&C test
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Scenario Events

SYN_Mendocino_M7.8 = Scenario, M7.8 Mendocino
Event ID: M7.8 Mendocino
Description: Mendocino area, finite fault with updates
Magnitude: M7.8; Location: 40.35, -124.95; Depth: 5 km
Event Notes: Legacy scenario

SYN_PointArena_M7.8 = Scenario, M7.8 Point Arena
Event ID: M7.8 Point Arena
Description: San Andreas fault N of San Francisco; finite fault with updates
Magnitude: M7.8; Location: 39.00, -123.69; Depth: 5 km
Event Notes: Legacy scenario

Point_Source/1857_FortTejon_M7.9 = Scenario, M7.9 San Andreas
Event ID: M7.9 San Andreas
Description: Fort Tejon, 1857-01-09 on San Andreas fault; point source, no updates
Magnitude: M7.9; Location: 35.43, -120.19; Depth: 5 km
Event Notes: Legacy scenario; Widely felt in California

SYN_Cajon_M7.8_Follow_Up = Scenario, M7.8 Cajon
Event ID: M7.8 Cajon
Description: San Andreas fault; Finite fault with follow-up
Magnitude: M7.8; Location: 34.82, -118.90; Depth: 5 km
Event Notes: Legacy scenario

SYN_SaltonSea_M7.8 = Scenario, M7.8 Salton Sea
Event ID: M7.8 Salton Sea
Description: San Andreas fault; Finite fault with updates
Magnitude: M7.8; Location: 33.35, -115.73; Depth: 5 km
Event Notes: Legacy scenario

SYN_Elsinore_M7.8 = Scenario, M7.8 Elsinore
Event ID: M7.8 Elsinore
Description: Elsinore fault, finite fault with updates
Magnitude: M7.8; Location: 32.53, -115.71; Depth: 5 km
Event Notes: Legacy scenario

Point_Source/RoseCanyon_M6.3 = Scenario, M6.3 Rose Canyon
Event ID: M6.3 Rose Canyon
Description: San Diego, late 1800's; point source, no updates
Magnitude: M6.3; Location: 32.625, -117.150; Depth: 3.5 km
Event Notes: Legacy scenario; felt throughout San Diego area
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Point_Source/2015_Olympic_Coast_M8.0 = Scenario, M8.0 Olympic Coast
Event ID: M8.0 Olympic Coast
Description: Off-shore Washington State
Magnitude: M8.0; Location: 47.797, -124.732; Depth: 23 km
Event Notes: Legacy scenario

Point_Source/2017_PortlandHillsFault_M7.1 = Scenario, M7.1 Portland Hills
Event ID: M7.1 Portland Hills
Description: Downtown Portland; point source, no updates
Magnitude: 7.1; Location: 45.525, -122.787; Depth: 9.0 km
Event Notes: Scenario; downtown Portland
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